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Master Page

When you design a master page you are creating a page that will hold common elements in your
document thatwill keep it consistent. If you use more than one page, it will enable you to edit or

update multiple elements at the same time. Multiple master pages can be used in a document such as a
newsletter in which you may use multiple styles and themes youmay want carried through the
document

Types of Elements in Master Pages i

Margins, Guides, Page Dimensions

Headers and Footers

Backgrounds and Watermarks

One or Two Page Layout

Text and Numbers

Insert ObjectsPictures, Clipart, Text Boxes, Date & Tif@ge Number and more
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1. Click on the View tab on the Ribbon
2. Click on Master Page option in tMaster Pagayroupat the left
a. A Master Page tab will open to Design and Edit the document
b. This will stay active until you close with the buttorthe close group
i. Anything you add in the Master Page view will be on all pages
ii. Hyperlinks added in the Master Page view will not work if you are sending your
document through email or website. Add hyperlinks in the normal view
c. If you want another Master Pag:lick on the Add Master Page option
i. Additional master pages are used when you want different repeated objects or
text
d. Two Page Master is used when you want to create a single page with two pages of
information-ex. A catalog paggee next page)
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Two Page Master
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1. Select Two Page Master when you want to design a book style document.
a. On the Pag®esignab you can change the size to your specifications

Apply To Options on the Master Page tab

1. Select your object
2. Click on the ApplTo option and choose from the menu
a. All Pages
b. ToCurrent Page
c. (hoose the correct Master Page (if you have multiple master pages)
3. As needed, edit size and place on each page the object is moved to
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Duplicate a Master Page

Rename a Master Page
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1. To duplicate a master page quickly:
a. Click on the Duplicate option
2. In the dialog box:
a. Page ID will be the next letter or what you choose
b. Description will name the original page name
c. Click OK

3. Torename a master page:
a. Select and right click the page in the Navigation pane
b. Click on the Rename option
4. In the dialog box:
a. Page ID will be displayed
b. Type the description in the Description text box
c. Click OK

Delete a Master Page
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1. To delete a master page:
a. Select the page in the Page Navigation pane
b. Click on the Delete option
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Add Header and Footer

To activate Header and Footer options:

1. dick show Header/Footer
2. Click options for Page Number,tBaTime

a. Click where you want thpage number, date or time
b. Page number will show the # sigrigse the Master page to see actual page numbers
c. You can add any information in the Header and Footer by typing it in the text boxes
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Edit Page Numbers and View Master Page List

1. Close the Master Page tab by clicking on the Red and White X in the middle of the ribbon

View Two- Page Spread

. Show Page Number on First Page

Insert Page...
#D
Insert Duplicate Page =
Lk Delete
. Top
3 Move...
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#_|
Insert Section )
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@ haster Pages 4 - D
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=
@

Edit Master Pages

Apply Master Page...

2. nght cI|ck the page in the Page Navigation pane to see the menu for options
3. Click on Page Numbers to choose position or format options
4. Click on Master Pages to view a thumbnail list of all master pages by name ant dptioas
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Tips and Reminders

% Objects added in the Master Page mode can onlgdited in the Master Page mode.
% Only objects addetb a Master Pag&hile editing a master page will ssible in the
Master Page mode

% Links made in the Master Page maoal# not work in the normal edit or viewing page

mode
% Create all links in the normal editing mode
% Add all text box and other objects in the normal editing mdlu&t are not a part of the

Master Page elements

% Close Master page when elements you want to kaspadded

% 2dz R2y Qi ¢lyid G2 IRR SftSYSy(aiedidIfypkS al &i
have multiple pages in your document, you will want to add and edit various elements
important to your document

% From the Insert tab Add blank pagtsese willshow the master page elements

% In the Navigation pane right click on a page to open menu options
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Create Styles and Themes

Creating your own font styles and themes uses the tools within the Publisher software or you can import
styles and themes from the Internet. You can also design new fonts or themes by changing the default
settings. If you are using a template it will aldgahave styles and themes set. You can change any
aspect of the template to fit the needs of your document. When starting with a blank document you will
need to create your own styles and themésyou have text already in the documenyou must select

the text box or the text to make any changes in the style or theme.

2] = 2 - I= Publicationl - Microsoft Publisher = B 2
File Insert  Page Design  Mailing Review  View s @
= ) - =5 4 B &4 Find -

A SR = q & A a T x
= By \_1 ¥ 4 I 25 Replace
Paste u As == Draw Picture Table Shapes .
=352 B U x x = = Styles | 1o poc N v Iz Align - Y [t Select
clipboard Font paragi Objects ange Editing
Import Styles... ]
New Style...

Styles T Font Features

You will find the Styles option on the Home tab. To open the New Style dialog box:
%= Click on the menu arrow below the Styles button

W ohy

GKS YSydzz Of A0]

2y bSs

%= New Style Dialog box opengpictured below)

Enter new style name:

Style Based Onmenu list arrow- No
Style, Accent Text, Address, Boc
Heading, Job Title, List Bullet, Norm.
Normal, Organization, Presentatio
Tagline or Title

Style for the followingparagraph:menu
list arrow (same options as Style Bas¢
Oon)

{adetsSx

MNew Style

[ =

Style based on:
Mormal

Enter news style name:

Style for the following paragraph:

Click to change

[ Font ...

[ Character spacing ...

[ Paragraph ...

[ Bullets and numbering ...

Sample

[ Horizontal rules ...

J
J
J
J
J
J

[ Tabs ...

Calibri

Calibri 10

Description

Mormal +

OK ] [ Cancel
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Font ¢ allows you to change the font style, siz
color, underline, effects and features

Character Spacing; allows you to shrink or
stretch text size, tracking and kerning

Paragraphg allows you to change indents an
spacing, tabs, and line and paragraph breaks

Bullets and Numbering; allows you to choose
size, indent, character

Horizontal Rule¢ allows you ¢ draw a line
before and/or after paragraph, chang
thickness, color, style and position

Tabsc¢ allows you to set tab positions for table
or columns, alignment and leaders

Click on the buttons to open the dialog box th

New Style B -
Enter new style name: Click to change ] }
Webinar Example Eont ...
Style based on:
Style for the following paragraph:
Webinar Example
P Iz‘ Bullets and numbering ...
/
sample
I »
C
ambria
I
I
I
Cambria 36
Description
Title 2 +
oK Cancel
N
Preview Click OK when
your completely
design finished
designinpallifont
style options.
General
F Font style Size
I [=] |eoldmalic [~] |24 [=]
underline Color:
trone) (-]
Effects
[ ] Superscript [ Shadow [ | Engrave
[] Subscript [ outline [ ] Small caps
[] Strikethrough [[]Emboss "] All caps
OpenType features
[+ swash
Default - 0 hd Contextual alternates
Ligatures: Stylistic Set
Standard Only = 7 =]
Sample
ﬁa&‘[o?gj
A
Gabriola 24
I oK I[ cancel |} o ] Help

contain design options for your dament. Each
Click to changdutton dialog box is displayed o
the following pages.

Options that have been chosen are displayed
the Sample/Preview section of the dialog box.

If Apply is activated click it before clicking on tl
OK button.

Clicking the OK button will close this box and all
you to choose another option in the New Sty
dialog box.
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Character Spacing

Character Spacingl @Ié,l
. . . Scaling
Options that have been chosen are displayed in - o ik o sretch sctecied tote [T TE

Sample/Preview section of the dialog box.

Tracking
Use this option to adjust the spacing for a highlighted block of text.

Hormal [=] By this amount: | 100% =
Kerning
Use this option to fine-tune the spacing between two characters.
¥ Expand El By this amount: | 0.25pt =
If Apply is activated click it before clicking on the ¢ ATTs e iy
[¥] Kern text at: 17pt = and above
button. Sampie

Clicking the OK button will close this box and allow
to choose another option in the New Style dialog box

Show Toolbar Apply oK | [ cancel

Measurement -
* 001" 2y 195" 2] = 53" gz 0s" = £ oo 2134 100% 2 Jear = E

Horizontal Position  <— Screen Tip Example

When you click on the Show Toolbar button, the toolbar opens at the bottom of the sc
displaying chosen options.

Design options are available in the toolbar without opening the dialog box. Screen tips v
visible when you point to each option onehoolbar.

You must highlight text to make changes in the toolbar options.
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Paragraph Options

Paragraph P | Paragraph I ) Paragraph I ol X
Indents and Spacing frabs | Line and Paragraph Breaks| lndentsand'Spacm abs Ente and Spacing | Tabs | Line and Faragraph Break
Tab stop position: Dm\dnvwfor han controf
Alignment: | Left E‘ Alignment | DKEEpwithF:legt
O Left ) Right [ Keep lines together
Indentation ) Center @ pecmal [] tart in next text box
Preset: Hanging Indent lz‘ Left: | 0.25" Léader 7 -
Eirst line: | -0.25" = Right: |0 © ere Ouwe___
@oot.... (C)Bullet = s e
Line spacing ()Dash - - - -
Before paragraphs: | 9pt = Between lines: | 1.25sp ——
After paragraphs: | 8pt = — —
[/]ialign text to baseline guldeé J;J !‘;J M
L_Sample
1. Choosealignment option: Example: These options for keeping tex
Left together or separate in line
Center ane . TWO. e 40 25
_ and paragraph breaks.
nght Thiree....... Fowr ... £.25 .
Justified _ _ Widow/Orphan control
Frve ... bl i S, 23 475 .
Distributed v * Widows and orphans are
Distribute all lines Column 1 is Left Align single lines of text in &€
2. Indentation style and Column 2 is Center Align wit]| paragraph that print at the
rr;easurementS' Dot Leader top or bottom of a text box or
Originall Column 3 is Decimal Aligl. column. You can choose t
with Dot Leader avoid separating these line
Flush Left P g

1% Line Indent
Hanging Indent
Quotation
Custom
3. Line Spacing
Before Paragraph
After Paragraph
Between Lines
4. Align text to baseline
guides
Place check in box
5. Sample/Preview box
displays the chosen options
6. Click OK when finished

1. Draw text box first
2. Set tabs by typing in the
inches measurement in the
Tab Stop Position box an|
click on Set. Add as many tg
stops needed

3. Choose Leader if needed
(DO NOT use Leader wit
column oneit will change
data position.)

4. Click Set button after eacl
tab designation to save it
5. Click OK when finished

If you have text already in the document you must
select the text box and/or the text to make any change
in the style or theme.

from the rest of the
paragraph.

Keep with next This check
box will keep one or more
selectal paragraphs together
in a text box or column.

Keep lines together This
checkbox will keep lines of &
paragraph together in a tex
box or column.

Start in next text box This
check box will move the
paragraph to overflow so thaf
you can move it to a new x
box.

Click OK when finished
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Bullets and Numbering

- Click on a bullet character to activat [
the Character Button and open th

Bullet Character window. —J
. —

- Scroll through to find the character yo = | 00 : B
want or look in the Recently use alsls71slo]: [ 1<[<[>]2 =l alB[x[alE 0| -
symbols and click on the character yc i 1|9 k| M[N|o|m]e[p[z|1|v|¢|o[=]#/z|f =
want, and then click the OK button. S| el By 8lelolyin] Lo kA v

n|8|plo|tjv|mle|& |y | {|]|]|}|~|0[0]0/0)0
O|0|o|o|o|o|ojg|o|ojg|ojg|o|ojg|ojolo|o

- The new character will be added to th ojcjojojojojojojojy] <] /|e|fs]|e|v]ale.
choices in the Bullets and Numberir
dialog box. (I e 1 o= 2 <[] o[s] o[ ] [

Wingdings: 74 Character code: [74 from: Symbol (deamal) [~

- You will se your new charactel
displayed in the Sample box.

- Try other options to view them in the
Sample preview section.

- Click the OK button when finished.
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